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Introduction
Scan ’n Store is a software product that allows organizations and
workgroups to easily scan, index, store, and retrieve large numbers
of graphics and documents. The ability to store information about
each scanned graphic or document means you can quickly search for
images based on specific keywords you define when you configure
the Scan ’n Store image database.

About this Manual
This manual assumes you know how to use a mouse, open a menu,
and choose menu and dialog box options. The book groups subjects
into two parts:
•  Part 1 — Introduction, Chapters 1 & 2

This section covers the Scan ’n Store documentation,
DocuStream contact information, software and hardware
requirements,  installation, and an overview of Scan ’n Store.

•  Part 2 — Chapters 3 - 10
This section covers how to use the software.

•  Part 3 — You can also refer to the Scan ’n Store Tutorial in
Appendix A for a quick introduction to using the software.
When you are using the software, you can refer to the online
help provided with Scan ’n Store.

To use the online help

•  Click on the Help button in the Scan ’n Store window.

•  Press F1 to display context-sensitive help.
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Documentation Conventions
This manual uses documentation conventions that closely resemble
those used in other Windows documentation

This… Means… Example

bold Menu names, dialog
boxes, and options.

Click Browse.

italic References to specific
files.

Open the AcctRcv.mdb
file.

ALL CAPS Specific keys. Press ENTER.
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Chapter 1
Installing Scan ’n Store

This chapter briefly describes everything you need to know about
installing Scan ’n Store. It includes information about system
requirements, installing, and starting Scan ’n Store.

Installing Scan ’n Store
To install Scan ’n Store,

1. Insert the Scan ’n Store CD-ROM in the drive.
(The installation program should start automatically. If it
does not, proceed to step 2.)

2. From the Windows Start menu, click Run.

3. Type d:\setup at the prompt, where “d” is the path of your
CD-ROM drive.

4. Click OK.

5. Follow the instructions that appear on the screen.
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Starting and Exiting Scan ’n Store
Use these instructions to start and exit Scan ’n Store.

To start Scan ’n Store,

1. From the Windows Start menu, click Programs.

2. Select Scan ’n Store 2.0.

3. Select Scan ’n Store.
(The start screen appears.)

To exit Scan ’n Store,

•  In the File menu, click Exit.
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Chapter 2
Administrative Overview

Scan ’n Store is a software product that allows organizations and
workgroups to easily scan, index, store, and retrieve large numbers
of graphics and documents. The ability to store information about
each scanned graphic or document means someone can quickly
search for images based on specific keywords the administrator
defines after installing the Scan ’n Store image database.

Unlike other programs that simply archive and store graphics,
Scan ’n Store keeps track of the relationships among the images to
make them easy to find and use.

Understanding Libraries
Scan ’n Store uses the concept of a “library” as a metaphor for
storing, identifying, and retrieving images. A Scan ’n Store library
consists of:

•  Groups of images stored in a database or directory.

•  Sets of keywords and descriptions stored in a Microsoft
Access database. The keywords and descriptions identify
groups of images and specific images within each group.

In the same way that you might use author names, titles, or subject
keywords to search for books in a library, you can define ways to
search for images in a Scan ’n Store library.
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Designing and Organizing Libraries
Before you begin working with Scan ’n Store to create a library of
images, take time to think about a few issues concerning how the
library should be organized so people can find what they want
quickly and efficiently. Like any real library, the organization of the
data affects the usability and usefulness of the information it
contains.

•  Use logical groupings of images in the library.

Determining differences and similarities between images
can help define possible search topics. For example, one
person might want to gather all the materials related to a
single author, while another might need to search for all the
materials created before a certain date.

•  Be specific when you define searchable fields for your
library.

Choose specific search categories that allow users flexibility
when searching. For example, users who want to search for
an author might want to search for all authors with first
names “William” or all authors with last names
“Shakespeare.” Thus you would want to provide two fields,
a “first name” field and a “last name” field, rather than a
single “name” field to accommodate more granular searches.

•  Use consistent naming conventions when you enter data
for each field.

Be consistent in your use of initial capital letters,
abbreviations, and numbering systems. Inconsistent use of
naming conventions can affect the reliability of a search.

The following examples illustrate two common type of libraries.
Each example includes tips for organizing library images and
highlights pitfalls you should avoid.
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Scenario 1: Storing purchase orders received
by large companies or businesses.

Businesses that deal with large volumes of incoming purchase orders
need to have a system to quickly and easily retrieve specific POs to
handle a variety of sales, administrative, and customer service
situations. To make the stored images accessible to these distinct
groups, begin by looking for categories of information common
among all the POs. These categories might include:

•  PO

•  Date

•  Company name

•  Total cost

•  Rep (sales representative name)

•  Paid (yes/no)

By creating individual fields for these categories, a librarian creates
a flexible set of search rules for users. For example,

•  Sales reps can enter their names in the “Rep” field to
retrieve records of all their sales. Additionally, they could
narrow the search by searching on a specific company name
to track their sales in an individual account.

•  Administrative personnel can pull records for all accounts
payable and view the signature on the POs to correctly
identify who in the purchasing company approved the PO.

•  Customer service can respond to customer inquiries by
searching for specific POs to verify that a PO was received
and that the account was paid.

Pitfall: Non-specific fields make record retrieval very difficult
and in some cases impossible. It might be tempting for some
librarians to include a single field for “Items Purchased” so users
could search based on the items a company purchases. To allow
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someone to search based on items purchased, you would have to
provide several “item” fields (item1, item2, item3,…) so that each
item could be entered into a separate item field.

Tip: Identify all common categories for your images, but create
fields only for those categories necessary to retrieve specific images.
Be specific about the information that will be entered into a field and
try to keep that information as granular as possible to enhance search
capabilities.

Scenario 2: Photographs of damaged property
for insurance claims.

Insurance companies often keep photographic records of damaged
property when clients file a claim. By themselves, these photographs
probably do not suggest clearly defined categories by which the
Scan ’n Store librarian should organize them. Instead, the librarian
must define a set of categories by identifying distinct sets of users
and understanding their needs.

For example, insurance agents wanting to search a library might
expect to be able to search based on these categories appearing as
fields in the Scan ’n Store database:

•  Name (of insured)

•  Policy Type (home, auto, health)

•  Policy

•  Incident  (of claim)

•  Date (of accident)

•  Notes (describing how the image relates to the claim)

However, if the insurance company has a set of photographers they
use frequently, the photographers might want to search a library
using fields defining categories like
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•  Date (of taking the picture)

•  Name (of photographer taking picture)

•  Type of photo (b/w or color)

•  Notes (describing image)

Pitfall: A narrow view of who will use a library can hinder its
overall usability. In the example above. The photographer’s set of
categories would make it difficult for insurance agents to find
specific images; likewise, the insurance agent’s set of categories
would make it difficult for photographers to find specific images.
The librarian needs to address the needs of both user groups by
creating a broad set of categories that will help both audiences find
what they need.

Tip: Carefully consider the needs of your audience when you
define categories. Ask yourself who will use the library?; why
might they be searching for an image in the library?; what
information will they be able to provide and expect to be able to use
to find a specific image? Categorizing the data what will be put into
a library often gives a good idea what fields must be contained in the
library for it to be used effectively.

Scan ’n Store Databases
Scan ’n Store allows you to store library data in either a native
Microsoft Access database or in an ODBC database. If you want to
store image data in an ODBC database type, you must manually
create the database tables and install the database as an ODBC
source before you can add images to the library from Scan ’n Store.
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Regardless of the type of database you use, the following tips can
help you create a functional, usable library:

•  For large libraries, store images in directories rather
than a database.

It is faster to retrieve images from a directory of images than
it is to pull them from a databse. If you attempt to retrieve a
large number of images from a library, you will get better
performance if the images are stored in directories.

•  Only use multiple libraries if you have specific
requirements or needs that make it necessary.

Scan ’n Store does not perform cross-reference searches
among libraries. Thus, if you needed to search for a set of
images that are spread among different libraries, you would
need to perform a search on each library individually.
Storage space limitations may require you to archive old
information in your library: use the export facility to remove
records based on date, PO, or some other category that can
be used to locate the data if you need it in the future. You
must manually track the library name and it’s location since
Scan ’n Store does not have the ability to track exported data
from library to library.

Access Databases
Scan ’n Store uses three tables in a Microsoft Access database to
track and manage images in a library.

IMPORTANT: We do not recommend altering the tables using
Microsoft Access or any other utility. Improper modifications can
affect the functionality and usability of your library.
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This table Contains

SNSData User-defined indices values entered during indexing.

SNSImage All images that have been added to the library.

SNSXRef Associations between one record (set of indices) from the
SNSData table and a specific image from the SNSImage table.

SNSOptions Library specific information such as the library image
directory and the indexing image directory.

SNSSpool A list of all images scanned or imported and awaiting
indexing.

ODBC Databases
The ODBC database uses the same tables as the Microsoft Access
database. The steps below explain how to create a typical ODBC
database for use with Scan ’n Store.

IMPORTANT: Only your system administrator should create or edit an
ODBC database for use with Scan ’n Store. Improper modifications
can affect the functionality and usability of your library.

To create an ODBC database,

1. Start the administration program for your database.

2. Create a new ODBC database with these five tables:
•  SNSData
•  SNSImage
•  SNSOptions
•  SNSSpool
•  SNSxRef
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3. Add the following field to the SNSData table.

 PK_ID  primary key, autoincrement integer

4. In the SNSData table, add all the fields you want to use to
index images in your library. (See “Designing and
Organizing Libraries” on page 6 for information on
determining fields for your library.)

5. Add the following fields to the SNSImage table.

PK_ID   primary key (autoincrement integer)
SNSImageDate   Date/Time in the form mm/dd/yy hh:mm:ss
SNSImageName text
SNSImagePath text
SNSImageIndexer text
SNSImageCreator text
SNSImageOriginalName text
SNSImageThumbnail Binary Large Object

(or your DBMS equivalent)
SNSImageImage Binary Large Object

(or your DBMS equivalent)
SNSImageAnnotations Binary Large Object

(or your DBMS equivalent)

6. Add the following fields to the SNSOptions table.

PK_ID primary key (autoincrement integer)
LibraryPath  text

(the path where the images will be
 stored after indexing)

IndexPath text
(the path where the images will be
stored prior to indexing)
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7. Add the following fields to the SNSSpool table.

PK_ID primary key (autoincrement integer)
Description text
Date Date/Time in same format as above
Creator text
Indexer text
Status text
OriginalName text
Path text

8. Add the following fields to the SNSXRef table.

FK_DataID integer (primary key)
FK_ImageID integer

9. After you create these fields, you should be able to open the
new ODBC database. (See “Opening Libraries” on page 29
for instructions.)
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Chapter 3
Navigating Scan ’n Store

Scan ’n Store combines all the features needed to create, maintain,
and use image libraries in a single interface that is both functional
and intuitive.

Using the Scan ’n Store Work Area

Toolbars control file
handling, cursor
functions, multiple-
page TIFF images,
and the appearance
of images in the
Image Viewer.

The Search
Window allows you
to browse a library
using FlexFolders,
search a library
using keywords, or
select a group of
images for indexing.

The Results
Window shows lists
of images either
retrieved from a
library after a search
or waiting to be
indexed and added
to a library.

The Image Viewer shows the images
selected in the Search Window
FlexFolders or Results Window lists .
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Use the To

Toolbars Choose to configure a library, enter images into a library,
ScanFix an image, search for images in a library, or export
images from a library.

Search
Window

Scroll through thumbnail versions of images in the library.

Results
Window

Review the results of a search run on an image library.

Image
Viewer

View a specific image in a library and enhance the
appearance of the image for printing.

Toolbars
Scan ’n Store uses four toolbars to control file handling, cursor
functions, multiple-page TIFF images, and the appearance of images
in the Image Viewer.
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File Toolbar

This toolbar allows you to control handling of libraries and images,
adjust Scan ’n Store settings, and perform common tasks like
printing.

  File Buttons

 
New Library Create a new library using the New Library Wizard.

 
Open Library Open an existing Scan ’n Store library.

 
Import Image Import an image into an open Scan ’n Store library.

 
Export Export images from a library.

 
Options Display the Options dialog box and adjust the settings

for Scan ’n Store.

 
Refresh Refreshes the contents of the Results Window, the

Search Window, and the Image Viewer. Use this if
you add images to a library from the Batch Index and
those images do not appear in the FlexFolders.

 
Cut Removes text from a field and copy the contents to the

clipboard

 
Copy Copies text or selected areas of an image to the

clipboard

 
Paste Pastes text from the clipboard into a selected field

 
Print Prints the image currently in the Image Viewer.

 
Image Info. Displays image size, dimensions, type, and # of colors.

 
About Displays the About Scan ’n Store dialog box,

showing copyright date and version number.
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Image Toolbar

This toolbar allows you to control how an image appears when it is
in the Image Viewer.

  Image Buttons

 
Zoom In Zooms in on an image. When you use this option,

the image remains centered but appears 50%
larger.

 
Zoom Out Zooms out on an image. When you use this option,

the image remains centered but appears 50%
smaller.

 
Rotate Left Rotates the image 90° counter-clockwise.

 
Rotate Right Rotates the image 90° clockwise.

 
Reset to Original Displays the image as it appeared when you first

opened it in the Image Viewer.

 
Actual size Displays the actual size of the stored or scanned

image in the Image Viewer.

NOTE: Typically, the actual size of a scanned or
stored image is much larger than the Image
Viewer. Use the scrollbars or the Hand Pan option
to view the rest of the image.

 
Full Image Displays the entire image in the Image Viewer.
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Image Quality Adjusts the quality of the image displayed in the

Image Viewer. Higher quality images look better
overall and provide more clarity for detailed
images, but they appear more slowly in the Image
Viewer and can slow performance when scanning
numerous images. Lower quality images might not
show details in images, but they appear more
quickly in the Image Viewer and can make
scanning through numerous images less time-
consuming.

Draft: Achieves best performance within the Image
Viewer. This option reduces image quality to
increase the speed at which Scan ’n Store draws
and refreshes images in the Image Viewer.

Better: Shows a good quality image and achieve
good performance within the Image Viewer. This
option strikes a balance between image quality and
the speed at which Scan ’n Store draws and
refreshes images in the Image Viewer.

Best: Shows best image quality within the Image
Viewer. This option displays the highest quality
images in the Image Viewer.

 
Shades of Gray Determines whether Scan ’n Store anti-aliases the

edges of an image using 4 or 16 shades of gray, or
not at all.

 
ScanFix Enhances the appearance and readability of single

images and multi-page TIFFs displayed in the
Image Viewer.
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Mouse Toolbar

This toolbar allows you to set the function of the mouse cursor
within the Image Viewer.

  Mouse Buttons

 
Flying Magnifier changes the appearance of the cursor in the View

Pane and allows you to temporarily magnify parts
of an image without increasing the size of the
image.

 
Stretch Zoom Zooms in on a selected part of an image. When

you use this option, the selected rectangle fills the
entire View Pane.

 
Hand Pan Moves an image in any direction within the View

Pane. Unlike the scrollbars, the Hand Pan tool
allows you to move (pan) images up or down and
left or right at the same time. Use this tool when
an image is larger then the View Pane on both the
horizontal and vertical axes.

 
Select Area Selects an area of an image with a solid rectangle.

 
Select Annotation Selects an annotation and activates an Attached

Note or Hyperlink to another graphic.

 
Edit Annotation Allows you to edit, move, resize, or delete an

annotation.

 
Draw Rectangle Adds a rectangle annotation to an image.

 
Draw Ellipse Adds an ellipse annotation to an image.

 
Draw Line Adds a line annotation to an image.

 
Add Text Adds a text annotation to an image.
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Page Toolbar

This toolbar allows you to navigate through the individual pages of
multi-page TIFF images.

  Page Buttons

 
First Page Displays the first page in a multi-page TIFF

image.

 
Previous Page Displays the page preceding the currently

displayed page in a multi-page TIFF image.

 
Page List Use this drop-down list to display a specific page

within a multi-page TIFF.

 
Next Page Displays the page following the currently

displayed page in a multi-page TIFF image.

 
Last Page Displays the last page in a multi-page TIFF

image.

Search Window
The Search Window includes all the tools you need to find images
in a Scan ’n Store image database. Three tabs provide easy access to
tools for browsing, keyword searching, and selecting images ready
to be indexed into the library.

Click Index to
display a folder view
of groups of images
ready to be indexed.Click FlexFolders to

display a hierarchical
folder view of an
image database and
browse for images.

Click Search to
display tools to
perform a keyword
search for indexed
images.
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Results Window
The Results Window includes two tabbed views that show lists of
images either already in an image database or waiting to be added to
an image database.

Search Results tab

The Search Results tab displays the images retrieved from a library
after a search. From this tab you can edit the field values assigned to
an image, browse images in a library, and delete images from a
library.
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Batch Index tab

After you scan documents using ScanDirector, acquire images from
a TWAIN device, or import some existing images, Scan ’n Store
places the image files in the Indexing directory and a list of the
images appears in the Batch Index tab. Before you add these images
to your library, you must index each of them by assigning values to
each required Name field in the Batch Index tab.

Image Viewer
The Image Viewer displays images selected in the FlexFolders,
Search Results tab, or Batch Index tab. You can use the Image
toolbar to resize, rotate, and enhance the quality of the image. Read
“Chapter 8: Viewing Images” for more information about using the
Image Viewer.
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Chapter 4
Managing Libraries

The model for the Scan ’n Store image database is the concept of a
library where images are stored and indexed using keywords. The
tools included in the program allow you to create, open, and
configure libraries quickly and easily.

Using the Library Tab
This tab allows you to define the categories used to describe each
image. You must assign a name for each category, determine what
type of information the category contains (numerical, textual, dates,
etc.), and whether or not the category is required before an image
can be added to the library.

Click Add Field to
display the Add Field
dialog box and
create a new Name
field for a library. The
new Name field will
appear in the Name
column when you
close the dialog box.

Click Remove Field
to remove selected
Name fields from a
library.

The Name column
shows the names of
the categories in a
library. Scan n Store
uses the values
shown in the Name
fields for indexing,
browsing, and
searching.

The Required
column shows
whether or not a
Name field must
contain data before it
can be added to a
library.

The Type columns
shows the type of
information a Name
field can contain.
Available types
include currency,
date, float, integer,
and text.
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This Does this

Shows the names of the categories in a library. Scan n Store
uses the values shown in the Name fields for indexing,
browsing, and searching. For example, a library that
contains images of classic cars might have
Make/Model/Year as field names.

Shows the type of information a Name field can contain.
Fields can contain text, integers, dates, currency (e.g.,
103.54), or floating point numbers (e.g., 18736.5597).

Indicates which Name fields must be filled-in before adding
images to a library. When adding images to a library, you
may want some information to be required when performing
a search. For example, part number might be required for
images of auto parts in a parts store. This column shows
whether or not a Name field must contain data before it can
be added to a library: NO means a Name field can be empty;
YES means a Name field must contain valid data.

Displays the Add Field dialog box and create a new Name
field for a library. The new Name field will appear in the
Name column when you close the dialog box.

Removes selected Name fields from a library. To select a
Name field, click on the value in the Name field column. (A
selected field will appear highlighted.)

CAUTION:  When you remove a Name field from a library it
cannot be undone. Make sure you do not need the Name
field for any images before you remove it from a library!
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Creating Libraries
When you first use Scan ’n Store, you may need to create a library of
images if one does not already exist. When you create a new library,
you can choose to store the images in either a database or a
directory. (A single library cannot store images in both a database
and a directory at the same time.)

NOTE: Before you create a new library, read “Understanding
Libraries” in Chapter 2 to learn about Scan ’n Store libraries.

If a library of images does not already exist, you need to build one.
Before you build your library, know four things:
•  What will you name your library?
•  Where do you want to store the images you keep in your library?
•  After you scan or import images, where do you want these

images to sit until you index them and add them to your library?
•  What categories do you want to use to organize the images in

your library?

When you have the answers to these questions, you are ready to
create a new library.

To create a new library,

1. Click  in the File toolbar.

2. Type c:\path\new.mdb in the Database Name field, where
“c:\path” is the drive on which you installed Scan ’n Store.

-or-

Click  to display the New Library Name dialog box,
choose the folder where you want to install the library, and
enter the library name in the File name field.

3. Click Next.
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4. Choose a directory where you want to store images for
indexing. Type c:\path\ in the first field, where “c:\path” is
the drive on which you installed Scan ’n Store.

-or-

Click  to display the Select Directory dialog box and
choose the folder where you want to store images for
indexing.

5. Choose a directory where you want to store library images.
Type c:\path\ in the second field, where “c:\path” is the
drive on which you installed Scan ’n Store.

-or-

Click  to display the Select Directory dialog box and
choose the folder where you want to store library images.

6. Click Next.
(An Open Error dialog box will display indicating that the
libraries do not exist.)

7. Click Yes to create the directories.

8. Click Finish to create the new library.
(After the New Wizard closes, Scan ’n Store displays the
Library tab from the Options dialog box so you can assign
categories to your library.)
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Opening Libraries
When you look for images using Scan ’n Store, you need to choose
which library the images are in. You can choose a library using the
Scan ’n Store menus, toolbar icons, or keyboard commands.

To open a library,

1. Mouse: Click  in the File toolbar.
Menu: From the File menu, select Open Library…

(The Open dialog box appears.)

2. If you are opening a library that uses a Microsoft Access 97
database, choose a database from the dialog box.

If you are opening a library that uses an ODBC database,
proceed to step 3.
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3. To open an ODBC database, choose the ODBC Databases
file type.

(The Select Data Source dialog box appears.)

4. In the dialog box, select the ODBC database you want to
open.
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Configuring Libraries
Libraries need to be well-configured to be useful to anyone
searching for an image or images. Configuring a library simply
means providing a logical means of searching for images using the
Fields table in the Search Window Search tab.

NOTE: Poorly configured libraries are difficult to use and can be a
support problem for the librarian. Before you configure your library,
read “Designing and Organizing Libraries” in Chapter 2 to learn
about basic questions you should ask before configuring Scan ’n
Store libraries.

Using the Fields table
The Fields table in the Library tab contains the categories you
assign to describe an image in a database. The table requires you to
complete three columns of information to define a category:

•  Name
•  Type
•  Required

Field

The Name is the name of the category. For example, a library
containing images of auto parts might include a category identifying
the manufacturer of each part. A logical field name for this category
would be “Manufacturer.”

To define a Field Type for a category,

1. Choose the Library tab from the Options dialog box.
(The Library tab shows any categories already defined for
your library.)
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2. Click Add Field… to open the Add Field dialog box.

3. From the Add Field dialog box, click in the Name field and
type the category name.

Type

Type describes the type of data you can use when you define
categories for images in a library. There are five types of field data
to choose from.

Use To allow only

Currency Money values in Data fields. (Do not include symbols like “$”
in the Data fields.) For example, 103.54.

Date Numeric date values in Data fields for a category. For example,
12/25/97 or 12-25-97

Float Floating point values, such as 18736.5597, in Data fields.

Integer Whole numbers in Data fields for a category.  For example, 0, 1,
2, 3, …, n.

Text Words and letters in Data fields for a category. You can only
use letters from the alphabet in “text” Data fields.
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To define a Field Type for a category,

1. Choose the Library tab from the Options dialog box.
(The Library tab shows any categories already defined for
your library.)

2. Click Add Field… to open the Add Field dialog box.

3. From the Add Field dialog box, click in the Type field and
select a value from the drop-down list.

Required?

Required? determines whether or not Name fields for a category
must contain data before an image can be added to a library.

To mark a category as required or optional,

1. Click  to open the Options dialog box

2. Choose the Library tab from the Options dialog box.
(The Library tab shows any categories already defined for
your library.)
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3. Click Add Field… to open the Add Field dialog box.

4. From the Add Field dialog box, click in the Required?
check box

Defining Categories for a Library
Each row in the Fields table defines a single category for images in a
library. You must fill in each field in a row to complete a category
definition. After you define categories for a library, you can go back
and modify them if you need to.

To define categories for a library,

1. Choose the Library tab from the Options dialog box.
(The Library tab shows any categories already defined for
your library.)

2. Click Add Field… to open the Add Field dialog box.

3. In the Name field, enter the name of the new category.
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4. From the Type list, select the type of data associated with
the new category.

5. Click in the Required? box to define a category as required
for all images.

6. Click OK to add the category to the library.
(The new category and its settings appear in the Library
tab.)

7. Repeat 2-6 until you have added all the categories you want
to define for your library.

8. Click OK in the Options dialog box to save the new
categories in your library.

You can go back and modify the category definitions at any time.
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Chapter 5
Adding Images to Libraries

Adding images to a Scan ’n Store library is a four-step process:

1. Importing image files.
2. Assigning keywords to images.
3. Enhancing image quality.
4. Adding images to the library.

The main tools for adding images to a library are the Batch Index
tab, the Indexing tab, and the Scan Images dialog box. This chapter
covers the use of these tools to complete each of the steps for adding
images.

Importing Image Files
When you import images in Scan ’n Store, the images are saved to a
directory, called the “batch”, where they remain until they are
indexed and added to the library. There are three ways to add images
to the batch,

•  Importing existing images
•  Scanning images
•  Acquiring images from TWAIN devices

NOTE: You cannot simply copy images to the batch indexing
directory to import them. Copied images will not appear in the Batch
Index tab, so they cannot be indexed and added to the library. You
must use one of the three methods to import images.



Importing Image Files 5–Adding Images to Libraries

38 Scan ’n Store 2.25  4-00

Importing Existing Images
Scan ’n Store lets you import the following file formats:

•  TIFF
•  PCX
•  BMP
•  JPEG
•  CALS
•  NIRS/NIF and NAV-C

Scan ’n Store saves all images imported using the Scan Images
dialog box as TIFF. If you have images ready, you can import them
directly into a Scan ’n Store library.

To import existing images,

1. Choose  or select Import Images… from the File menu.
(The Open dialog box appears.)

2. Select the file or files you want to import.
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3. Choose Open.
(The images you selected appear in the Batch Index tab,
ready for indexing.)

Scanning Images
You can scan a document using the ScanDirector software included
in Scan ’n Store. By using ScanDirector to scan your documents,
you can add scanned images directly to your library without first
saving them to a directory. (If your scanner supports TWAIN, see
“Acquiring Images from TWAIN Devices” on page 45.)

To scan a document using ScanDirector, select the Scan… option
from the File menu to open the ScanDirector dialog box. This dialog
box lets you set up your scanner, configure scan jobs, and start or
stop scanning documents.

NOTE: ScanDirector supports only binary (2 bit) data so all data
obtained from ScanDirector supported scanners is saved as TIFF
Group 4.
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Configuring Your Scanner

The “Scanner” area of the dialog box controls the setup of your
scanner. The options available in this area change depending on
what driver you choose and what scanner you select. If some options
are not available for your scanner, they will be grayed to indicate
they are inactive. For example, if your scanner does not support
automatic document feeders, the ADF button will be grayed. Scan ’n
Store remembers any changes you make to the Job configuration the
next time you open the dialog box.

Choose Front to scan
the front of a
document; Back to
scan the back. Select
Front and Back to
scan both sides.

Choose this button to
display the Open
dialog box. Select a
scanner driver for
Scan ’n Store to use

Choose ADF to scan
documents from a
document feeder.
Choose Bed to scan
from the scanner
bed.

This box displays the current
scanner. Clicking the down
arrow displays a list of
scanners the selected driver
supports.

This box displays the
current resolution.
Clicking the down
arrow displays a list
of resolutions your
scanner supports

Move the marker to
the left to decrease
scanning brightness;
to the right to
increase scanning
brightness.

Move the marker to
the left to decrease
scanning contrast; to
the right to increase
scanning contrast

This box displays the
current page size.
Clicking the down
arrow displays a list
of page sizes your
scanner supports.
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To configure a scanner before scanning an image,

1. Select Scan… from the File menu.
(The ScanDirector dialog box appears.)

2. Click on the Choose Driver button.
(The Open dialog box displays.)

3. Select the Windows scanner driver for your scanner.

4. Click in the Scanner box to display a drop down list of
scanners supported by the driver you chose.

5. Select your scanner from the list.
(The options available in the Scanner and Job areas of the
dialog box should change from gray to white.)

6. From the Source area, choose a paper source.
•  ADF selects an automatic document feeder.
•  Bed selects the scanner bed

7. From the Side(s) area, select the sides of a document you
want to scan. (You can choose both.)
•  Front scans the front of a document.
•  Back scans the back of a document.

8. Click in the Resolution box to display a drop down list of
resolutions your scanner supports.

9. Select a resolution from the list.

10. Click in the Page Size box to display a drop down list of
page sizes your scanner supports.

11. Select the page size of the document you want to scan.

12. Adjust the Contrast and Intensity levels as needed.
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Configuring Your Jobs

The “Jobs” area of the dialog box controls how you want to scan
your documents. The options available in this area change depending
on what driver you choose and what scanner you select. If some
options are not available for your scanner, they will be grayed to
indicate they are inactive. For example, if your scanner does not
support automatic document feeders, or if Bed is selected as the
paper source, the Batch Scan and Multi-Page options will be
grayed. Scan ’n Store remembers any changes you make to the Jobs
configuration the next time you open the dialog box.

You can control how many pages you want to scan, depending on
the capabilities of your scanner.

Use To scan

Single Page One page at a time.

Batch Scan All the images in the feeder tray.
(Only available for scanners with document feeders.)

Choose Single Page
to create an image
for each page you
scan or Multi-Page to
save multiple
scanned images to a
single TIFF file

A solid bar shows
the progress as the
scanner scans a
page.

Choose Single Page
to scan one page  or
Batch Scan to scan
multiple pages
(requires a document
feeder).
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You can also control whether Scan ’n Store saves the output from a
job to individual files or to one multi-page file.

Use To

Multi-Page Scan multiple scanned documents to one image. For
example, you might use this when you are scanning all the
pages of a long contract so you can make sure the pages stay
together.
(Only available for scanners with document feeders.).

Single Page Save scanned documents to their own individual files.

To configure a job,

1. Select Scan… from the File menu.
(The ScanDirector dialog box appears. The “Scanner” area
controls the hardware setup for your scanner; the “Job”
area controls the setup for a scan job.)

2. Choose a scan method.
•  Single Page scans one document per job.
•  Batch Scan scans all documents in a feeder tray in one

job.

3. From the Output area, choose how you want to save your
scanned images.
•  Multi Page saves all the documents in a job to a single

multi-page TIFF file.
•  Single Page saves each page in a job to its own TIFF

file.
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Scanning Documents

After you set up your scanner and configure your jobs, you are ready
to scan your documents. The Scan Images dialog box allows you to
start and stop your jobs and view the progress of a document being
scanned.

NOTE: Refer to the documentation that came with your scanner to
make sure you have it properly installed.

To start a scan job,
•  Choose the Scan button from the Scan Images dialog box.

The Scan button becomes gray (inactive) and the Cancel
button becomes the Stop scanning button.

The Page status bar fills with a solid color to indicate the
progress of each page being scanned.

To stop a scan job,
•  Choose the Stop scanning button from the Scan Images

dialog box

The Page status bar disappears to indicate a stopped job.

The Scan button becomes active again and the Stop
scanning button returns to the Cancel button.

To cancel a job,
•  Choose the Cancel button from the Scan Images dialog box.

The ScanDirector dialog box disappears.
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Acquiring Images from TWAIN Devices
Scan ’n Store supports the use of TWAIN devices for image input.
TWAIN (Technology Without An Independent Name) is an
industry-standard protocol that allows communication between
application programs and input devices such as scanners and digital
cameras.  If your scanner is not TWAIN compliant, you can use the
Scan Images dialog box to configure your scanner and scan jobs for
use with Scan ’n Store.

To scan using TWAIN devices,

1. From the File menu, choose Select TWAIN Source… to
display the Select Source dialog box.

2. From the Select Source dialog box, click  on the TWAIN
driver for your scanner and then click the Select button.
Choose a 32-bit driver if one is available.
(The Select Source dialog box closes. You will not need to
select a TWAIN source again, unless you install another
TWAIN device on your system.)

3. From the File menu, choose Acquire TWAIN Data… to
open your TWAIN scanning utility.
(The TWAIN scanning utility that shipped with your scanner
appears. Use the utility to scan the document(s) you want to
import into the library. Exit the utility after you finish
scanning.)



Importing Image Files 5–Adding Images to Libraries

46 Scan ’n Store 2.25  4-00

4. To scan more documents, repeat step 3.
(The scanned image will appear in the Batch Index tab.)

About TWAIN Images in Scan ’n Store

Scan ’n Store receives images from TWAIN data sources in BMP
format and saves the images as shown in the table below.

This color depth… Is saved as…

2 bit TIFF Group 4

4 bit BMP

8 bit JPEG

16 bit BMP

24 bit JPEG

32 bit BMP

Others1 BMP

If a file is saved as a BMP file you will be notified via a dialog box
that the file is being saved as a BMP file.  BMP files are very large
and take up a great deal of hard drive space.  If possible you should
choose a color depth of 2,8 or 24 bits as output from your TWAIN
device.

                                                     

1 The BMP file specification only allows for 2, 4, 8, 16, 24 and 32
bit data - any other color depth is non-standard and may not be
supported by any particular image viewer.
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Indexing Images
After you import an image, and before you add it to a library, you
need to index the image by assigning keywords to it. This allows
users to look up the image when they need it. Because other people
will need to be able to find the image in the library, be sure to
choose logical keywords that accurately describe the image and its
contents.

To index images,

1. Click on the Index tab in the Search window.

(The Batch Index tab in the Results window becomes
active.)

2. Click on the Batch folder ( ) in the
Search window.
(The Batch Index tab displays a list of all the images in the
Indexing directory.)

3. Click on a row number from the left of the window to select
an image from the Batch,
(The selected image will appear in the Image Viewer.)

4. Click in any field that you want to use to index the selected
image.
(Red names indicate that this field is required for all images
in the open library.)
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5. Enter a value in the field or select one from the drop-down
list.

6. Repeat steps 4-5 for all required fields and as many
unrequired fields as possible. The more fields you index the
easier it is for others to search for images in the library.

7. After you finish indexing an image, you can either begin
indexing all the other images in the Batch, or you can go
ahead and add to the image library.

To delete an image from the batch,

1. Click on the Index tab in the Search window.

(The Batch Index tab in the Results window becomes
active.)

2. Click on the Batch folder ( ).
(The Batch Index tab displays a list of all the images in the
Indexing directory.)
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3. Click anywhere on a row to select an image from the Batch,
(The selected image will appear in the Image Viewer.)

4. Press CTRL+DELETE to remove the image from the batch.
(An alert dialog box appears.)

5. Click Yes to delete the image; click No to keep the image in
the batch.

Using Default Keywords
You can choose to assign new, unique keywords for each image
individually. However, if you are sorting a large group of closely-
related images that might share the same keywords, you can define a
set of default keywords that immediately populate the Name fields
when you import an image and it appears in the Batch Index tab.
Use the Indexing tab in the Options dialog box to define default
values for each Name field defined in the Library tab.

To define a set of default keywords,

1. Click  or select Options… from the Tools menu.
(The Options dialog box appears.)
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2. Choose the Indexing tab.

3. Enter the keywords in the Default fields beside the
appropriate Field name.

4. Choose OK to accept the default keywords you assign, or
choose Cancel to close the dialog box without making any
changes.

The next time you import an image or group of images, the fields in
the Batch Index tab will automatically fill with the default
keywords you assigned.
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Enhancing Image Quality
When you scan documents and save them as images, the quality of
the image can sometimes be less than desirable for use in an image
library. The ScanFix utility included in Scan ’n Store corrects the
most common problems found in scanned images.

Problem What ScanFix does

Skew
(Images scanned
at an angle)

Realigns an image along the vertical and horizontal planes
uses text and horizontal lines as guides. The resulting
image is slightly larger than the original image

Noise
(Random flecks
in images.)

Removes random flecks of noise based on the size of the
flecks and whether or not the flecks are isolated (not near
or touching anything else).

Dot Shading
(Large blocks
of color become
splotchy gray
patches)

Removes large areas of dot shading based on the size of
the dots that make up the shaded area.

Before adding an image to a library, check to see if the document
appears to have any of these common scanning problems. Fixing
these problems increases the readability of an image and can reduce
the size of the image file.

To enhance the quality of an image,

Mouse: Click  in the Image toolbar.
Menu: In the Edit menu, select ScanFix…

NOTE: You should see the image change in the Image Viewer. If the
problems you identified are not fixed after using ScanFix, you, refer
to “Chapter 10: Using ScanFix” for help on adjusting ScanFix to
meet your needs.
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Adding Images to a Library
After you assign keywords and fix any problems with the appearance
of a scanned image, you are ready to save the image in your library.

To add indexed images to a library,

•  In the Image menu, select Add Batch to Library .
(Scan ’n Store will add all the indexed image to the library.
Any unindexed images, or images that do not have values
for all the required fields, will remain in the batch.)

Deleting Imported Images
If you decide not to add an imported image to the library, you can
remove it from the set of imported images.

To delete an imported image,

1. Use the FlexFolders or Search tabs to find the image you
want to remove.
(Read “Chapter 6: Finding Images in Libraries” for more
information.)

2. Press CTRL+DELETE to remove the image from the
library.
(An alert box appears.)

3. Choose Yes to delete the image, choose No to keep the
image in the library.
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Chapter 6
Finding Images in Libraries

Scan ’n Store provides two methods for finding images in a library.
•  Browsing with FlexFolders
•  Searching with Keywords

The results of either method will appear in the Search Results tab in
a scrollable list.

Using the Search Results Tab
The Search Results tab displays the images retrieved from a library
after a search. From this tab you can edit the field values assigned to
an image, browse images, and delete images from a library.

Click on the headings in the top row  to sort
images in the Search Results tab based
on the values in this column before
browsing the results list.

Click in any field to edit the index value for
an image. You can choose any existing
values using a drop-down list, or enter a
new value.

Click on the number for an
image to view the image in the
Image Viewer, or to delete the
image from the library.
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Browsing with FlexFolders
FlexFolders allow you to browse an open library based on a
hierarchical view of categories in the library. What makes
FlexFolders so useful, is their ability to display information in many
different ways. You can rearrange the hierarchy so the FlexFolder
display information to accommodate the way your work.  When you
click on any FlexFolder, all the images it contains appear in the
Search Results tab.

In this example, our library has four categories: Subject, Format,
Title and Date with the following sort order:

Date>Title>Format>Subject

The “root” folder shows the name of the open library and the
number of images the library contains. Clicking on this folder
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would show all the images in a library in the Search Results
tab.

Folders marked “Empty” do not have values assigned to a
category. The empty folder in the example indicates that no date
was assigned to two images. Clicking on this folder would show
the two images with empty date categories in the Search
Results tab.

All other FlexFolders show the Name value assigned to each of the
categories defined for the open library. This example shows that the
library contains a black and white drawing of a circuit diagram
entered into the library on July 2, 1999.

If we were to reverse the sort order in the FlexFolders tab to this:

Subject>Format>Title>Date

then, our folder tree showing the circuit drawing would look like
this:
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To find images using FlexFolders

1. Click  or select Options… from the Tools menu.
(The Options dialog box appears.)

2. Choose the FlexFolders tab from the Options dialog box.
(The FlexFolder tab shows the order in which categories
will appear in the FlexFolder tree.)

3. Use the FlexFolders tab to determine which categories you
want to include in the FlexFolder tree and the order in which
they should appear.

4. Click OK to accept your changes and close the Options
dialog box.

5. Double-click on the “root” folder to open it and display the
nested folders.
(A list of all the contents of the library fills the Search
Results  tab. The first image in the list appears in the Image
Viewer.)

6. Open a nested folder to narrow your search.
(The Search Results tab now only shows the images
contained within the nested folder you selected.)

7. Continue to open nested folders until the set of images or a
specific image appears in the Search Results tab or the
Image Viewer.

Changing the Sort Order
FlexFolders allow you to browse the images in a library based on a
sorting order. This tab allows you to determine the sorting order. By
default, the Name fields appear in the Selected Fields list in the
order that they appear in the Library tab. You can change their
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order or remove them to the list of Available Fields using the center
column of buttons.

To add a field to the sort order,

1. Click on a Name in the Available Fields list.

2. Click Add to move the selected field to the Selected Fields
list so it will appear in the FlexFolders Tree.

To remove a field from the sort order,

1. Click on a Name in the Selected Fields list.

2. Click Remove to move the selected field to the Selected
Fields list so it will appear in the FlexFolders Tree.

The fields appearing
in the Available
Fields list do will not
appear in the
FlexFolders Tree.
Click on a field to
select it (highlight)
before you add it to
the Selected Fields
list and to the
FlexFolders Tree

Click Remove to
move a field from the
Selected Fields list
of the Available
Fields list and
remove it from the
FlexFolders Tree.

The order in the
Selected Fields list
determines the
hierarchy in the
FlexFolders tree.
Click on a field to
select it before you
move it up, down, or
remove it from the
FlexFolders Tree.

Click Move Down to move the highlighted field
in the Selected Fields list down to a lower
branch in the FlexFolders Tree.

Click Add to move a
field from the
Available Fields list
to the Selected
Fields list so it will
appear in the
FlexFolders tree.

Click Move Up to move the highlighted
field in the Selected Fields list up to a
higher branch in the FlexFolders Tree.
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To move a field up in the sort order,

1. Click on a Name in the Selected Fields list.

2. Click Move Up to move the selected field up in the Selected
Fields list order so it will appear in the FlexFolders Tree.

To move a field down in the sort order,

1. Click on a Name in the Selected Fields list.

2. Click Move Down to move the selected field down in the
Selected Fields list order so it will appear in the FlexFolders
Tree.

Searching with Keywords Choose this column
to display a list of
comparison values.
Use the values to
narrow the scope of
your search..

Choose Search to
search a library for
images that match the
search criteria defined
in the table.

Choose this column
to enter the keyword
for your search.
Keywords must be of
the type defined in
the Configure tab.
(For example,
Integer fields can
only contain whole
numbers.)

This column displays
the list of Field
Names defined in the
Configure tab.

This box allows you
to manually edit the
search parameters
Scan ’n Store will
use to retrieve
images from a
library. As you enter
Comparison values
and Criteria values in
the table on the
Search tab, the free-
form fills with the
resulting search
string.

Choose the Reset button to returns all the
fields in the Search tab to their default
values.
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The Search tab provides all the tools you need to search for images
in a library. When you click on the tab, all the fields in the table are
blank. You can fill all, some, or none of the fields to perform a
search, depending on the scope of your search.

Finding All Images
In some cases, you might want to find all the images in a library. For
example, if you wanted to edit the keywords for the Field Names of
all the images in your library, you could run a search for all the
images in the library and edit the keywords from the Image List.

To find all images in a library,

1. After you open a library, choose the Search tab.

2. Click the Search button in the window.
(The Search Results tab displays all the images in the
library.)

3. Click on the heading at the top of any column to sort the
images in the Search Results tab based on the contents of
that column.
(Scan ’n Store sorts the images alphabetically and
numerically.)

4. Use the scroll bars to browse images that scroll out of the
window.

5. Click anywhere in a row to display the image in the Image
Viewer.
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Narrowing Your Search
Usually, you will only want to find a small group of images in a
library. To do this, you need to narrow the scope of your search by
choosing keywords which Scan ’n Store uses to retrieve matching
images. Use the “Comparison” and “Criteria” fields to define your
search.

Using Comparison Values

Each field in the Comparison column of the Search tab contains a
drop down list with the following options. You can use them singly
or in combination to customize your search. For more granular
control of your search, use the “free-form search” box to edit the
search string Scan ’n Store uses to retrieve images from the library.

Use To

= Find images matching the value entered in “Criteria”

< Find images with alphabetic or numeric values less than
the value in “Criteria.”

<= Find images with alphabetic or numeric values less than
or equal to the value in “Criteria.”

> = Find images with alphabetic or numeric values greater
than or equal to the value in “Criteria.”

> Find images with alphabetic or numeric values greater
than the value in “Criteria.”

<> Find images with alphabetic or numeric values that are
not equal to the value in “Criteria.”

Like Find images containing the value in “Criteria.” (For
example, searching for “ca” would return images with
values of “car,” “because,” and “candles.”)
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To narrow your search using search criteria,

1. Choose the Search tab.

2. Choose an option from the “Comparison” field beside one of
the Field Names.
(An arrow appears to the right of the field.)

3. Click on the down arrow to display a list of possible
comparison values.

4. Click in the corresponding “Criteria” field and enter a
keyword.

You must enter a value of the type defined for the Name
field in the Library tab. For example, if the field uses the
“Date” type, you must enter a value in the form defined by
the Regional Settings in your Windows 95/98/NT Control
Panel.

If there is already a value in the field, that value will
disappear as soon as you start typing.

5. Repeat steps 2–4 for all the Name fields you want to use to
narrow your search.

6. After you fill in the fields, click the Search button.
(The Search Results tab displays all the images in the
library that match your search parameters.)

7. Click on the heading at the top of any column to sort the
images in the Search Results tab based on the contents of
that column.
(Scan ’n Store sorts the images alphabetically and
numerically.)

8. Use the scroll bars to browse images that scroll out of the
window.



Searching with Keywords 6–Finding Images in Libraries

62 Scan ’n Store 2.25  4-00

9. Click on a row number at the left of the window to view an
image.

NOTE: The more Name fields you define, the more you narrow your
search. If you are looking for specific images, use as many Name
fields as possible to define your search.

Free-Form Searching
The bottom of the Search tab contains a text box that allows you to
manually edit the search parameters Scan ’n Store will use to
retrieve images from a library. As you enter comparison values and
keyword criteria in the table, the free-form box fills with the
resulting search string. For example, if you have a Name value of
“State” and you select “=” as the comparison value and search for
“OK”, the following appears in the free-form search box:

Scan ’n Store places quotation marks around values entered into
fields with a Type of “text.”  If you add to your search using a Claim
Number field name with “>” as the comparison value and “1000” as
the criteria value, the following appears in the free-form search box:

Parentheses group each set of search operations. Scan ’n Store
defaults to using AND to join the search operations together. Use
brackets around values that contain spaces.
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Using Free-Form Search Criteria

The free-form search box also allows you to search using additional
comparisons, including:

OR, NOT, NOT=, !=

For example, suppose you wanted to run the search outlined above,
but you wanted to include all the images with State = “TX”.
You could manually edit the search box to form the following search
string:

((State = “OK”) OR (State = “TX”)) AND
([Claim Number] > 1000)

Suppose that you also wanted to include all images with claim
numbers equal to or greater than 1000 and all images with Date field
values greater than 1/1/97. The following search string should return
all matching images.

((State = “OK”) OR (State = “TX”)) AND
(([Claim Number] >= 1000) or (Date >
1/1/1997))

Resetting Search Parameters
After you perform a search on a library and view the results, you
might want to perform a new search based on a new set of search
keywords. You can use the Reset button to reset all the search fields
to their default values before you define your new search.

To reset the search fields,

•  In the Search tab, click Reset.
(All the fields in the Search tab become blank.)
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Deleting Images From a Library
You might run a search to find a list of images you want to delete
from a library. For example, if your library contains images of parts
specifications, you might want to delete specifications for parts no
longer in use.

CAUTION: Deleting an image deletes the image file from the directory
or database where it is stored. Do not delete an image unless you are
sure you no longer need it.

To delete an image,

NOTE: Before you delete images from a library, search for images
you want to delete and display them in the Search Results tab.

1. In the Search Results tab, find the image to delete.
(You can rearrange the order in which the images appear by
clicking on the headings at the top of each column.)

2. After you find the image you want to delete, click anywhere
in the row associated with the image.

3. In the Edit menu, select Delete Image.
     -or-
Press CTRL+DELETE on your keyboard.
(A dialog box ask if you want to delete the image.)

4. Click Yes to delete the image or No to keep the image.

5. Repeat steps 1-4 for each image you want to delete.



Changing Image Index Values 6–Finding Images in Libraries

Scan ’n Store 2.25  4-00 65

Changing Image Index Values
As your needs or the way you use libraries change, you may wish to
edit the values you originally assigned when you indexed your
images.  Or, you may wish to enter values for fields originally left
blank. (See “Indexing Images” on page 47 for information on how to
index images in the Batch Results tab.)

1. Use the FlexFolders or the Search tab to find the images
you want to re-index.

2. Click on a column heading to sort the images in the Search
Results tab based on the contents of that column.
(Scan ’n Store sorts the images alphanumerically.)

3. Use the scroll bars to browse images that scroll out of the
window.

4. Click anywhere in a row to select an image.
(The selected image will appear in the Image Viewer.)

5. Click in the first field you want to edit, then enter a value in
the field or select one from the drop-down list.

6. Repeat steps 1-3 for all the images and fields to edit.
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Printing Images
After you search for and retrieve images from a library, you can
print them to any installed printer.

To print an image,

1. Click  in the File toolbar.
(The Print dialog box appears.)

2. If you are printing a multi-page TIFF file, select the pages to
print in the Print Range area.

3. Click OK to print the pages or Cancel to close the dialog
box without printing.



Scan ’n Store 2.25  4-00 67

Chapter 7
Exporting Images from Libraries

After you search a library and retrieve a list of matching images, you
can export those images to another Scan ’n Store library. Reasons
for exporting libraries might include:

Library management. As your libraries grow, it might be a
good idea to break a single large library into smaller, more
manageable libraries.

Archiving. As images in a library become unnecessary or
obsolete, you might want to move them to an archival library
rather than deleting them.

Distribution. Departments and branch offices may only need
access to part of a library. You could export images from a large
central library to smaller departmental libraries.

Exporting to Existing Databases
The following steps describe how to export images from one library
to another using the Export Wizard. At any step during the export
process, you can use the wizard’s Back button to go to a previous
step, or  click Cancel to stop the export and close the Export
Wizard.

1. Click  or choose Export… from the File menu to start
the Export Wizard .
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(The Select Data Set pane appears.)

2. Choose to export all images or only those images appearing
in the Search Results tab. Click Next.
(The Select Destination Database pane appears)
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3. Click  to display the Destination Database dialog box
and choose the target database for the images.

4. If you are opening a library that uses a Microsoft Access 97
database, choose a database from the dialog box. Skip to
step 8.

If you are opening a library that uses an ODBC database,
proceed to step 5.
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5. To open an ODBC database, choose the ODBC Databases
file type.

(The Select Data Source dialog box appears.)

6. In the dialog box, select the ODBC database you want to
open.
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7. Click OK.

8. Click Next.
(The Complete pane appears in the wizard.)

9. Click Finish.
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Exporting to New Databases
The following steps describe how to export images from a library to
a new Access ’97 database using the Export Wizard. At any step
during the export process, you can use the wizard’s Back button to
go to a previous step, or click Cancel to stop the export and close
the Export Wizard.

1. Click  or choose Export… from the File menu to start
the Export Wizard .
(The Select Data Set pane appears in the wizard.)
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2. Choose to export all images or only those images appearing
in the Search Results tab. Click Next.
(The Select Destination Database pane appears.)

3. Click  to display the Destination Database dialog box
and choose the target database for the images.

4. Click Next.
(A message box asks if you want to create the database.)
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5. Click Yes.
(The Choose Image Directories pane appears in the
wizard.)

6. Click the first  button to display the Browse for Folder
dialog box and choose the folder where you want to store
images for indexing.

7. Click the second  button to display the Browse for
Folder dialog box and choose the folder where you want to
store library images.
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8. Click Next.
(A message box asks if you want to create the directories.)

9. Click Yes.
(The Complete pane appears in the wizard.)

10. Click Finish.
(Scan ’n Store creates the directories for the new database
and exports the images and data to the new library. The new
library contains the same categories as the originating
library, and the images have the same index values
associated with them.)
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Chapter 8
Viewing Images

The Image Viewer in the Scan ’n Store window provides a large set
of tools to adjust how you view an image.

Sizing Images
The following menu options allow you to adjust the size of the
image in the Image Viewer.

Zooming In 50%
Use the Zoom In 50% selection to zoom in on an image. The image
remains centered but appears 50% larger.

To Zoom In on an image,

Mouse: Click  in the Image toolbar, or
Menu: In the Image menu, select Zoom In , or
Keyboard:  Press CTRL+UP ARROW.

Zooming Out 50%
Use the Zoom Out 50% selection to zoom out on an image. The
image remains centered but appears 50% smaller.

To Zoom Out on an image,

Mouse: Click  in the Image toolbar.
Menu: In the Image menu, select Zoom Out .
Keyboard: Press CTRL+DOWN ARROW.
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Using Preset Image Sizes
The Image Viewer includes a set of tools to allow you to quickly
zoom to a few of the most desirable image sizes.

Reset to Original

Use the Reset selection to display the image as it appeared when you
first opened it in the Image Viewer.

To view the original image,

Mouse: Click  in the Image toolbar.
Menu: In the Image menu, select Reset to Original.
Keyboard: Press CTRL+R.

Actual Size

Use the Actual Size selection to display the actual size of the stored
or scanned image in the Image Viewer.

NOTE: Typically, the actual size of a scanned or stored image is much
larger than the Image Viewer. Use the scrollbars or the Hand Pan
option (page) to view the rest of the image.

To view the actual size of an image,

Mouse: Click  in the Image toolbar.
Menu: In the Image menu, select Actual Size .
Keyboard: Press CTRL+A.
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Full Image

Use the Full Image selection to display the entire image in the
Image Viewer.

To view the full image,

Mouse: Click  in the Image toolbar.
Menu: In the Image menu, select Full Image.
Keyboard: Press CTRL+F.

Rotating Images
Sometimes it is necessary to rotate images in order to view them
correctly. (For example, if someone scans an image upside down.)
The Image Viewer tool menu offers two options to rotate images:
Rotate Left and Rotate Right.

Rotate Left
Use the Rotate Left selection to rotate the image 90° counter-
clockwise.

To rotate the image 90°°°° left,

Mouse: Click  in the Image toolbar.
Menu: In the Image menu, select Rotate Left.
Keyboard: Press CTRL+LEFT ARROW.
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Rotate Right
Use the Rotate Right selection to rotate the image 90° clockwise.

To rotate the image 90°°°° right,

Mouse: Click  in the Image toolbar.
Menu: In the Image menu, select Rotate Right.
Keyboard: Press CTRL+RIGHT ARROW.

Setting Image Quality
You can adjust the quality of the image displayed in the Image
Viewer. Higher quality images look better overall and provide more
clarity for detailed images, but they appear more slowly in the Image
Viewer and can slow performance when scanning numerous images.
Lower quality images might not show details in images, but they
appear more quickly in the Image Viewer and can make scanning
through numerous images less time-consuming. The Image Viewer
tool menu provides three options to adjust image quality: Draft,
Better, and Best.

Draft
Use the Draft selection to achieve best performance within the
Image Viewer. This option reduces image quality to increase the
speed at which Scan ’n Store draws and refreshes images in the
Image Viewer.

To display “draft” quality images,

Mouse: Click  in the Image toolbar; in the sub-menu select
Draft.
Menu: In the Image menu, select Quality; in the sub-menu
select Draft.
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Better
Use the Better selection to display a good quality image and achieve
good performance within the Image Viewer. This option strikes a
balance between image quality and the speed at which Scan ’n Store
draws and refreshes images in the Image Viewer.

To display “better” quality images,

Mouse: Click  in the Image toolbar, in the sub-menu, select
Better.
Menu: In the Image menu, select Quality; in the sub-menu,
select Better.

Best
Use the Best selection to achieve best image quality within the
Image Viewer. This option displays the highest quality images in the
Image Viewer.

To display “best” quality images,

Mouse: Click  in the Image toolbar, in the sub-menu, select
Best.
Menu: In the Image menu, select Quality; in the sub-menu,
select Best.

Adjusting Anti-Aliasing
Scan ’n Store uses anti-aliasing to enhance the appearance of images
in the Image Viewer. Anti-aliasing smooths jagged edges on
graphics and text in images to make them more readable and more
like the original document. However, anti-aliased images can slow
the performance of the Image Viewer. To allow you to balance
performance and appearance, Scan ’n Store lets you set the number
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of shades of gray it uses to anti-alias an image, where more shades
of gray creates a better reproduction of the original document.

To set the number of shades of gray,

Mouse: Click  in the Image toolbar; in the sub-menu click
None, 4  Shades, or 16 Shades.
Menu: In the Image menu, click Shades of Gray; in the sub-
menuclick None, 4  Shades, or 16 Shades.

Fixing Scanned Images
When you scan documents and save them as images, the quality of
the image can sometimes be less than desirable for use in an image
library. The ScanFix utility included in Scan ’n Store corrects the
most common problems found in scanned images.

Problem What ScanFix does

Skew
(Images scanned
at an angle)

Realigns an image along the vertical and horizontal planes
uses text and horizontal lines as guides. The resulting
image is slightly larger than the original image

Noise
(Random flecks
in images.)

Removes random flecks of noise based on the size of the
flecks and whether or not the flecks are isolated (not near
or touching anything else).

Dot Shading
(Blocks of color
become splotchy
gray patches)

Removes large areas of dot shading based on the size of
the dots that make up the shaded area.

To enhance the quality of an image,

Mouse: Click  in the Image toolbar.
Menu: In the Image menu, select ScanFix…
Keyboard: Press CTRL+S.
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NOTE: You should see the image change in the Image Viewer. If the
problems you identified are not fixed after using ScanFix, refer to
“Chapter 10: Using ScanFix” for help on adjusting ScanFix settings.

Using the Mouse in the Image Viewer
You can change the function of the left mouse button in the Image
Viewer. There are often times when you might want to zoom in on a
small portion of an image. (For example, to see the signature on a
scanned image of a letter.) The Image Viewer provides two tools for
zooming in on parts of images: Flying Magnifier and Stretch
Zoom. The Hand Pan tool allows you to manually position an
image within the image viewer. The Select Area tool allows you to
highlight a specific area of the image

Flying Magnifier ( )
The Flying Magnifier tool changes the appearance of the cursor in
the Image Viewer and allows you to temporarily magnify parts of an
image without increasing the size of the image.

To magnify parts of an image,

1. Click  to enable the Flying Magnifier tool and cursor.
(The cursor looks like a rectangular magnifying glass when
you move it over the Image Viewer.)

2. Click on the part of the image you want to magnify.
(A beveled window appears over the image. Within the
window is a magnified view of the image.)

3. Continue to hold down the left mouse button and move your
mouse across the image.
(The beveled window moves across the image and shows a
magnified view of each part of its trail.)
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Stretch Zoom ( )
Use this selection to zoom in on a selected part of an image. When
you use this option, the selected rectangle fills the entire Image
Viewer.

To zoom in on a selected part of an image,

1. Click  to enable the Stretch Zoom tool and cursor.
(The menu disappears and the cursor looks like a round
magnifying glass with cross-hairs above it.)

2. Place the cross-hairs at one corner of the rectangular area
you want to select.

3. Click the left mouse button and hold it down while you drag
the cursor across the area you want to select.
(A rectangle will appear to show the selected area.)

4. When the area you want to select is contained within the
rectangle, release the mouse button.
(The selected area within the rectangle fills the entire Image
viewer.)

Hand Pan ( )
Select Hand Pan to move an image in any direction within the
Image Viewer. Unlike the scrollbars, the Hand Pan tool allows you
to move (pan) images up or down and left or right at the same time.
Use this tool when an image is larger then the Image Viewer on both
the horizontal and vertical axes.
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To pan an image,

1. Click  to enable the Hand Pan tool and cursor.
(The menu disappears and the cursor looks like an open
hand.)

2. Place the hand anywhere on the image in the Image viewer.

3. Click the left mouse button and hold it down while you drag
the cursor in the direction you want to pan the image.

4. Release the mouse button when the image is where you want
it or when you reach the edge of the Image viewer.
(The hand will not move beyond the Image viewer.)

5. Repeat steps 2-4 until the image is where you want it.

Select Area ( )
Use Select Area to mark a region of an image with a solid rectangle.

To select a region with solid color,

1. Click  to enable the Select Area tool and cursor.
(The menu disappears and the cursor looks like a hand
holding a pen with cross-hairs. ).

2. Place the cross-hairs at one corner of the rectangular area
you want to select.

3. Click the left mouse button and hold it down while you drag
the cursor across the area you want to select.
(A solid rectangle will appear to show the selected area.)

4. When the area you want to select is contained within the
rectangle, release the mouse button.
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5. When the area you want to select is contained within the
rectangle, release the mouse button.

Viewing Multiple-Page TIFF Images
The TIFF file format allows multiple pages to be saved within a
single file. The Image Viewer is able to load these files and provides
a set of tools to allow you to view each of the pages within the TIFF
image. The Image Viewer tool menu provides four options to view
pages within a TIFF image: First Page, Previous Page, Next Page,
and Last Page.

First Page
Use the First Page selection to view the first page in an image.

To view the first page in a TIFF image,

Mouse: Click  in the Image toolbar.
Menu: In the Image menu, select First Page.
Keyboard: Press SHIFT+UP ARROW.

Previous Page
Use the Previous Page selection to view the page preceding the
currently displayed page in a multiple page TIFF image.

To view the previous page in a TIFF image,

Mouse: Click  in the Image toolbar, or
Menu: In the Image menu, select Previous Page , or
Keyboard: Press SHIFT+LEFT ARROW.
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Next Page
Use the Next Page selection to view the page following the
currently displayed page in a multiple page TIFF image.

To view the next page in a TIFF image,

Mouse: Click  in the Image toolbar.
Menu: In the Image menu, select Next Page.
Keyboard: Press SHIFT+RIGHT ARROW.

Last Page
Use the Last Page selection to view the last page in an image.

To view the last page in a TIFF image,

Mouse: Click  in the Image toolbar.
Menu: In the Image menu, select Last Page.
Keyboard: Press SHIFT+DOWN ARROW.
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Goto Page
Use the Goto Page selection to go to a specific page in an image.

To go to a specific page in a TIFF image,

Mouse: Click  in the Image toolbar, then select a page
in the drop-down list.
Menu: In the Image menu, select Goto Page…. In the Goto
Page dialog box, select a page number.

       
Keyboard: Press CTRL+G.
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Chapter 9
Working With Annotations

Scan ’n Store allows you to add four types of annotations to your
stored images: boxes, ellipses, lines, and text. With annotations, you
can highlight important parts of images, insert notes. From the Image
Viewer, you can create, select, edit, move, resize, and delete
annotations.

Creating Annotations
The Image Viewer allows you to create the following four types of
annotations.

This type Does this

Box Lays a box with a on top of the image in the Image Viewer.

Ellipse Lays a ellipse with a border on top of the image..

Text Inserts a single line of text over the image in the Image
Viewer. Scan ’n Store defaults to using the Arial font for the
text.

Line Inserts a black line over the image in the Image Viewer.
You can add arrow heads to on or both ends of the line
using the Annotation Properties dialog box described in
“Editing Annotation Properties” on page “92.”.
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To create annotations

1. Choose one of these icons from the Mouse toolbar.

  Annotation Icons

 
Draw Rectangle Adds a rectangle annotation to an image.

 
Draw Ellipse Adds an ellipse annotation to an image.

 
Draw Line Adds a line annotation to an image.

 
Add Text Adds a text annotation to an image.

2. Hold down the left mouse button and drag the mouse to
adjust the size of the annotation.

3. Release the mouse button to create the annotation.

When creating text annotations, the following dialog box
prompts you for the text string after you release the mouse
button.
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Selecting Annotations
The Activation options (None, Hyperlink, Attached Note) control
the effect of clicking on an annotation with the Select Annotation
tool enabled. The options have the following effects:

If you choose Then

None Nothing happens

Hyperlink A graphic specified in the Hyperlink text box
appears

Attached Note Text entered in the Attached Note text box
appears.

To select an annotation,

1. Choose  from the Mouse toolbar to enable the Select
Annotation tool.

2. Move the mouse cursor over an annotation.

(The cursor changes to as it moves over an annotation.)

3. Click once on the desired annotation to execute the
Hyperlink or display the Attached Note.
(The annotation will be outlined when selected. In the
graphic below, the ellipse is the selected annotation.)
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Editing Annotation Properties
You can change the appearance of annotations using the Annotation
Properties dialog box. The dialog box changes depending on the type
of annotation you select to edit. Click on the annotation type you
want to edit to display the appropriate dialog box, then click on the
dialog box elements for help on how to use them.

To edit annotation properties,

1. Choose  from the Mouse toolbar to enable the Edit
Annotation tool.

2. Double-click on the annotation you want to edit.
(The Annotation Properties dialog box appears. The actual
properties available in the dialog will depend on the
annotation type.)

3. Click OK to keep any changes you make or Cancel to
discard changes.
(Delete removes the selected annotation from the image.)

NOTE: The Hyperlink and Attached Note activations are not available
in this version of Scan ’n Store.

To delete annotations:

1. Choose  from the Mouse toolbar to enable the Edit
Annotation tool.

2. Double-click on the annotation you want to delete.
(The Annotation Properties dialog box appears.)
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3. Click Delete to delete the selected annotation.

To move an annotation using the mouse,

1. Choose  from the Mouse toolbar to enable the Edit
Annotation tool.

2. Click and hold the mouse button over the desired annotation.
By moving the mouse, you can drag the annotation outline to
the desired location and release the mouse button to drop the
annotation.
(The annotation remains selected after it has been moved.)

To resize an annotation using the mouse,

1. Choose  from the Mouse toolbar to enable the Edit
Annotation tool.

2. Click once on the desired annotation.
3. Move the mouse cursor near the edge or corner of the

selection rectangle.
(The mouse cursor should change to a resize cursor
[double-ended arrow].)

4. Click and hold the mouse button to start resizing.
5. Drag the mouse until the annotation selection rectangle

indicates the desired size, then release the mouse button.
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Using the Annotation Properties Dialog Box
The Annotation Properties dialog box you see when you double-
click on a selected annotation depends on the type of annotation you
are editing. The following pages briefly describe the options
available on annotation type dialog box.

Box and Ellipse Annotations
The Box and Ellipse annotation types share the same properties. The
title bar for the dialog box below indicates the Ellipse annotation
type, but the same dialog box is used for the Box annotation type.
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This option Does this Default

Left Determines how far from the left side of
a graphic the annotation should begin (in
pixels).

N/A

Top Determines how far from the top of a
graphic an annotation should begin (in
pixels).

N/A

Width Determines the width of an annotation
(in pixels).

N/A

Height Determines the height of an annotation
(in pixels).

N/A

Color Map For all elements in an image appearing
beneath an annotation, this option
converts all non-white elements to values
of the selected Fill Color. For example,
if you picked Fuscia as a Fill Color, all
black elements would appear as Fuscia,
and all non-black elements would appear
as lighter shades of Fuscia

If neither Color Map nor Transparency
are selected, the Fill color of the
annotation becomes opaque and
obscures the area of the image beneath it.

not checked
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Transparent For all elements in an image appearing
beneath an annotation, this option
converts all non-black elements to values
of the selected Fill Color. For example,
if you picked Fuscia as a Fill Color, all
white elements would appear as Fuscia,
and all non-white elements would appear
as darker shades of Fuscia.

If neither Color Map nor Transparency
are selected, the Fill color of the
annotation becomes opaque and
obscures the area of the image beneath it.

checked

Border Width You can include a border around your
annotation to make them more visible.
This option sets how wide the border
appears (in pixels).

1

Border Color You can change the color of borders
around annotations by selecting a color
from the drop down list.

black

Fill Color When you create a box or ellipse
annotation, Scan 'n Store fills the
annotation with color. You can change
the filled color by selecting a color from
the drop-down list.

red

Activation The Activation options (None,
Hyperlink, Attached Note) control the
effect of clicking on an annotation with
the Select Annotation tool enabled. The
options have the following effects:

� None. Nothing happens.
� Hyperlink. A graphic specified in

the Hyplerlink text box appears in
the Image Viewer.

� Attached Note. Text entered in the
Attached Note box appears.

None
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Text Annotations
The Annotation Properties dialog box for the Text annotation type
includes options to control font color, style, typeface, and content.
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This option Does this Default

Left Determines how far from the left side of
a graphic the annotation should begin (in
pixels).

N/A

Top Determines how far from the top of a
graphic an annotation should begin (in
pixels).

N/A

Width Determines the width of an annotation
(in pixels).

N/A

Height Determines the height of an annotation
(in pixels).

N/A

Bold Changes annotation text to bold type. Not checked

Italic Changes annotation text to italic type. Not checked

Strikeout Changes annotation text to strikeout
type.

Not checked

Underline Changes annotation text to underline
type.

Not checked

Transparent
Background

Renders the annotation background
transparent, regardless of the
Background Color selected. If this
option is not checked, the background
changes to the selected background
color.

Checked

Text Contains the text that appears in the
annotation.

N/A.

Font Determines the font used to display the
annotation on a graphic. To change the
font, select a font from the drop-down
list.

Arial
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Foreground
Color

Determines the color of the text in the
annotation. Select from the drop-down
list to change the text color.

black

Background
Color

Determines the color of the background
in the text annotation. The background
color is only visible if the Transparent
Background option in not checked.

white

Text Style Shows the appearance of the annotation
text based on options selected in the
dialog box.

N/A

Activation The Activation options (None,
Hyperlink, Attached Note) control the
effect of clicking on an annotation with
the Select Annotation tool enabled. The
options have the following effects:

� None. Nothing happens.
� Hyperlink. A graphic specified in

the Hyplerlink text box appears in
the Image Viewer.

� Attached Note. Text entered in the
Attached Note box appears.

None
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Line Annotations
The Annotation Properties dialog box for the Line annotation type
includes options to control line width, line color, and whether or not
arrow heads appear on the ends.

This option Does this Default

Left Determines how far from the left side of
a graphic the annotation should begin (in
pixels).

N/A

Top Determines how far from the top of a
graphic an annotation should begin (in
pixels).

N/A
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Width Determines the width of an annotation
(in pixels).

N/A

Height Determines the height of an annotation
(in pixels).

N/A

Line Width Determines the width of the selected line
(in pixels).

1

Line Color You can change the color of the line
annotation by selecting a color from the
drop-down list.

black

Arrow Heads Choose an option from the drop-down
list to change the appearance of the ends
of a line annotation.

� Start places an arrow head at the
point where you begin your line
annotation.

� End places an arrow head at the
point where you end your line
annotation.

� Both places arrows at both ends of
a line annotation.

no arrow heads
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Activation The Activation options (None,
Hyperlink, Attached Note) control the
effect of clicking on an annotation with
the Select Annotation tool enabled. The
options have the following effects:

� None. Nothing happens.
� Hyperlink. A graphic specified in

the Hyplerlink text box appears in
the Image Viewer.

� Attached Note. Text entered in the
Attached Note box appears.

None

Annotation Storage
Annotations are stored in a file separate from the image.  The name
of the file is the same name as the image but with a file extension of
.ANN.  For example, annotations for image PARROTS.JPG would
be stored in PARROTS.ANN.  When an image is loaded that has a
corresponding annotation file, the annotations are automatically
loaded and displayed. Upon unloading an image, if annotations have
changed (created, deleted, moved, resized, etc.), you will be
prompted to save the annotations.
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Chapter 10
Using ScanFix

ScanFix enhances the appearance and readability of images
displayed in the Image Viewer. Use ScanFix before adding a library
an image to a library or when viewing or printing images already in
a library. In either of these instances, the default setting for the
ScanFix utility will probably be adequate. If you find the default
settings are not producing the desired result, you can adjust them
from the ScanFix tab in the Options dialog box.

Choose this tab to
adjust the Dot
Shading settings.

Choose this tab to
adjust the Noise
Removal settings.

Choose this tab to
adjust the De-Skew
settings.

Choose this button to
return all the
ScanFix settings to
their default values.

Choose this button to
accept any changes
you make to the
ScanFix settings.

Choose this button to  cancel any changes
you made to the ScanFix settings. This
button does not restore default values.
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Adjusting “De-Skew”
Sometimes images are scanned at angles that affect the appearance
and readability of an document image. Skew refers to how much
rotation the text in a scanned image has in relation to the horizontal
plane. ScanFix includes a De-Skew tab to control how it uses text
and horizontal lines to detect and remove skew from an image.

In addition to improving appearance and readability, De-Skew can
decrease the file size of scanned images because it improves the
effectiveness of image compression algorithms. De-Skew will also
increase the height and width of your image.

Sets the shortest line ScanFix uses to De-Skew. Slide
the marker to the right to detect only longer lines; to
the left to allow detection  of shorter lines.

Detemines how
much skew ScanFix
allows in an image.
Slide the marker to
the right to increase
the amount of
rotation ScanFix will
allow in images; to
the left to decrease
the allowed rotation.

Removes rotational
distortion from De-
Skewed characters.
Check this box to
improve appearance
and readability of
text in De-Skewed
images.
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The following images show the same image before and after using
ScanFix to de-skew.

Before After
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Using ScanFix on Multi-Page TIFFs
When you use ScanFix on multi-page TIFFs, you can select which
pages of the image you want to fix. If you choose to ScanFix a multi-
page TIFF, the ScanFix Preview dialog box appears. You can
immediately click Fix Image to fix all the pages, or you can select
individual pages. As you select individual pages, the last selected
page will appear in the window at the left of the dialog box.
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Removing Noise From Images
When you scan documents, things like imperfections in paper or
particles on the scanner bed can add speckles to a scanned image.
Introducing these speckles to a scanned image is called “noise.”
ScanFix includes a Noise Removal tab to control how it detects
noise in an image and removes the speckles to improve the
appearance and readability of an image.

Click this box to tell
ScanFix to check to
see if a group of
pixels is part of a
vertical line or
character

Removes specks that are not touching
anything else in the image. Slide the marker
to the right to remove larger specks.

Click this box to tell
ScanFix to check to
see if a group of
pixels is part of a
horizontal line or
character.

Defines the maximum horizontal length for a fleck that ScanFix will recognize as
noise and remove from an image. Slide the marker to the right to increase the
max. length; to the left to decrease the max. length.

Defines the
maximum vertical
length for a fleck that
ScanFix will
recognize as noise
and remove from an
image. Slide the
marker to the right to
increase the max.
length; to the left to
decrease the max.
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ScanFix uses the Noise Removal settings to determine how it
identifies parts of a scanned image as “noise.” The following table
summarizes the functions of each of the tools in the Noise Removal
tab and how they affect ScanFix.

Use To

Horizontal
Despeckle

Define the maximum horizontal length for a fleck that
ScanFix will recognize as noise and remove from an
image.  ScanFix examines each horizontal line (a single
pixel high) and deletes any group of black pixels whose
length is less than this value. You can increase this value
to remove larger specks, but if you set this value too high
you might remove segments of text from your image.

Vertical
Despeckle

Define the maximum vertical height for a fleck that
ScanFix will recognize as noise and remove from an
image.  ScanFix examines each vertical line (a single pixel
wide) and deletes any group of black pixels whose length
is less than this value. You can increase this value to
remove larger specks, but if you set this value too high
you might remove segments of text from your image.

Protect Vertical
Lines from
Horizontal
Despeckle

Tell ScanFix to check to see if a group of pixels is part of
a vertical line or character. ScanFix will not delete groups
of pixels that are part of vertical lines or characters.

Protect
Horizontal Lines
from Vertical
Despeckle

Tell ScanFix to check to see if a group of pixels is part of
a horizontal line or character. ScanFix will not delete
groups of pixels that are part of horizontal lines or
characters.

Isolated
Despeckle

Removes specks that are not touching anything else in the
image. Slide the marker to the right to remove larger
specks. Sliding the marker too far to the right can cause
ScanFix to remove periods and the dots on the letters i and
j. Experiment with this feature to get the best results for
your images.
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Removing Dot Shading From Images
Black and white images use dithering, or “dot shading,” to simulate
shades of gray or color found in the scanned documents. ScanFix
includes a Dot Shading tab to control how it detects areas of dot
shading in an image and removes the areas to improve the
appearance of an image. Removing dot-shaded regions can also
decrease the file size of images. The following image shows the
controls for noise removal and the callouts describe their use.

Sets the width of the
smallest dot-shaded
area you want
ScanFix to remove.
Slide the marker to
the left to detect
thinner dot-shaded
areas.

Sets the maximum size of individual dots in a dot-shaded area that ScanFix
will remove. If ScanFix removes part, but not all of a dot-shaded area, undo
the ScanFix, slide the marker farther to the right, and repeat the ScanFix to
remove the larger dots.

Sets the height of the
smallest dot-shaded
area you want
ScanFix to remove.
Slide the marker to
the left to detect
shorter dot-shaded
areas.
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Use To

Dot Height Set the height of the smallest dot-shaded area you
want ScanFix to remove. Slide the marker to the
left to detect shorter dot-shaded areas.

Dot Width Set the width of the smallest dot-shaded area you
want ScanFix to remove. Slide the marker to the
left to detect thinner dot-shaded areas.

Dot Size Set the maximum size of individual dots in a dot-
shaded area that ScanFix will remove. If ScanFix
removes part, but not all of a dot-shaded area, then

click  from the Image toolbar to undo the
ScanFix, slide the marker farther to the right, and
repeat the ScanFix to remove the larger dots.
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Appendix A
Quick Start Tutorial

This appendix introduces you to the Scan ’n Store work area and
teaches you some common procedures. Read this appendix to learn
how to use Scan ’n Store program.

Section 1: Searching Libraries
The lessons in this section use a sample library of images provided
for this tutorial when you installed Scan ’n Store. The library
contains a set of scanned purchase orders maintained in an accounts
payable database.

Lesson 1: Search a Library
In this lesson, you will learn how to do the following:

•  Open an image library.

•  Search an image library.

•  Display and print a particular image.

Before You Begin

1. Start Windows 95/NT.

2. Select “Scan ’n Store” from the “Scan ’n Store” group in the
Start Menu.
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Open a Library

1. Click  from the File toolbar.
(The Open dialog box displays.)

2. Go to the Samples directory to view the sample databases
Scan ’n Store installed on your computer.

3. Double-click on Accounts Payable.mbd in the dialog box to
open the sample database.
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Search the Library Database

To search the database:

1. Click the Search tab to display the options in the tab.

2. Click the Search button in the tab.

 Scan ’n Store displays all the images in the library in the list at the
bottom of the window. However, for very large libraries, this
kind of search is not the most effective way to find a particular
image. To find a particular image in a large image database, you
will want to narrow the number of listed images by using the
information associated with the images when they were entered
into the Scan ’n Store image library.

To narrow the search:

The Department column in the Search Results tab shows two
possible values: PS and Corporate. Let’s assume we know the
purchase order we seek is in Department “PS” and was issued
before December 15, 1997.

1. In the Search tab, click in the Criteria field of the
“Department” Field Name.
(An arrow appears to the right of the field.)

2. Click on the arrow and select “PS” from the drop-down list.

3. Click in the Comparison field of the “Date” Field Name.
(A drop-down list appears in the field.)

4. In the drop-down list, select the “<” option.

5. Click in the Criteria field of the “Date” Field Name.
(The current date appears in the field.)
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6. In the field, select the date 12/15/97 using one of the
following methods.

•  Click in each of the date/month/year areas and type the
values.

    

•  Click in each of the date values and use the spin box
(  ) to select the values.

•  Click  to display a calendar, then use the calendar to
select the date.

7. Click on the Search button.
(Scan ’n Store now only displays the images that have a
value of PS in the Department column and have a Date
earlier than 12/15/97.)

This narrowed the list to two images. Now you can view the
images in the Image Viewer to determine which image you need.
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Lesson 2: Sort the Search Results List
The Search Results list not only displays the list of images retrieved
from a search, but is also an interactive tool that can help you find a
particular image. You can sort the contents of the list based on any
of the headings in the first row.

To sort list:

1. In the Search tab, click the Reset button then click the
Search button.
(The Search Results tab again shows all the images in the
Accounts Payable library.)

2. In the Search Result tab, click on any heading in the list.
(Scan ’n Store sorts the contents either alphabetically or
numerically, depending on the field type.)

Lesson 3: View Images With the Image Viewer
The Image Viewer shows a large display of the image selected in the
Thumbnails or in the Image List. The viewer also allows you to
affect the appearance of the image for viewing and printing.

Zoom In/Out on Images

1. In the Search Results tab, click on any image in the list.
(The image should appear in the Image Viewer.)

2. Click  in the Mouse toolbar to make the image appear
50% larger in the viewer.

3. Click  in the Mouse toolbar to make the image appear
50% smaller in the viewer.
(You can repeatedly zoom in or out on an image to make it
as large or small as necessary. You can also quickly change
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the size of the image based on a set of common Scan ’n
Store image sizes.)

4. Click  in the Mouse toolbar to display the actual size of
the scanned purchase order.
(Typically, the actual size of an image will not fit within the
Image Viewer.)

5. Click  in the Mouse toolbar to display the whole image
within the viewer.

In some cases, you may want to zoom on a specific portion of an
image.

Rotate Images

Sometimes, scanned documents can be difficult to read due to the
orientation of the page. The following steps show you how to rotate
images within the Image Viewer to make them easier to read.

1. In the Search Results tab, find the image that has
“Knowledg” in the Company column and click anywhere in
the row of that image.
(A purchase order to “Knowledge Asset Media” should
appear in the Image Viewer.)

2. This image is a multi-page TIFF, which means several
scanned pages are saved in a single image file. We want to
see the second page in this image file.

To view the second page, click  in the Page toolbar.
(The drop-down list box in the toolbar will change to
indicate the current page.)

3. Click  in the Image toolbar to rotate the image.
(The image should rotate 90° clockwise.)
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Now, you can use the zoom features to size the image for easier
reading on-screen.

Improve Image Quality

Scan ’n Store allows you to adjust the quality of the black and white
images in the Image Viewer. (You cannot adjust the quality of gray-
scale or color images.) Adjusting Scan ’n Store to display using low-
quality increases the performance in the Image Viewer. This means
images load more quickly, you can scroll or pan images more
quickly, and you can resize images more quickly. However, the
image will be harder to read and can appear chunky with jagged
lines. Improving the image quality enhances the appearance of the
image, but slows the performance of the Image Viewer.

Let’s view the image we just rotated using the highest and lowest
quality settings.

For lowest quality settings,

1. Click  from the Image toolbar, then select Draft from
the list.

2. Click  from the Image toolbar, then select None from
the list.

The image should have jagged lines and small type should be
difficult to read.

Now, for highest quality settings,

1. Click  from the Image toolbar, then select Best from the
list.

2. Click  from the Image toolbar, then select 16 Shades
from the list.
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The jagged lines should appear smoother with these settings.
The text in the image should grow darker and thicker as Scan ’n
Store alters it to make it more readable.

Zoom on Selected Portions of an Image

The text in most images is too small to easily read on-screen.
Scan ’n Store provides two methods for magnifying portions of an
image within the Image Viewer: using the Stretch Zoom and Flying
Magnifier tools.

The Stretch Zoom tool allows you to select a portion of an image
and fill the Image Viewer with that piece of the image.

To use the Stretch Zoom tool,

1. In the Search Results tab, choose the image with the value
“15708” in the Purchase Order column.
(An image with red annotations should appear in the Image
Viewer.)

2. Click  to fit the full image within the Image Viewer.

3. Click  in the Mouse toolbar.

(The cursor changes to a magnifying glass  when you
pass the it over the Image Viewer.)

4. Using the left mouse button, click in the top left corner of
the portion of the image circled with a red elliptical
annotation, hold the mouse button down as you drag the
cursor to the lower right corner of the section (a black box
should mark the area selected), and release the mouse
button.
(The selected area should grow to fill the Image Viewer. You
should see $1147.52 in large text.)
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5. Click  to fit the full image within the Image Viewer
again.

For images where you have a lot of portions you want to magnify,
going through these steps over and over again can be tedious. For
frequent magnifications in a single image, the Flying Magnifier tool
is very useful.

To use the Flying Magnifier tool,

1. Click  to make sure the full image appears within the
Image Viewer.

2. Click  in the Mouse toolbar.

(The cursor changes to a different magnifying glass 
when you pass the it over the Image Viewer.)

3. Move the cursor over the red ellipse and click the left mouse
button and hold it down.
(The area within the ellipse should enlarge within a beveled
border. The enlargement will continue until you release the
mouse button down.)

There is one other difference between the two methods for zooming
on portions of an image—image quality. The Stretch Zoom
enlargement (at left) takes advantage of any quality settings you use,
whereas the Flying Magnifier enlargement shows the enlargement
without using any of the quality settings.
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Print a Selection

1. Click  in the File toolbar.
(The Print dialog box appears.)

2. Click OK to print all the pages in the image.

Go to “Section 2: Entering Images Into Libraries”
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Section 2: Entering Images Into Libraries
The lessons in this chapter use a sample Scan ’n Store database
installed with the software and a sample image file. For a library to
continue to be useful and current, it is usually necessary to add
images to it.

In this chapter, you will learn how to do the following:

•  Scan documents with Scan ’n Store.

•  Select images to enter into a library.

•  ScanFix an image to enhance readability.

•  Assign keywords to field names.

•  Add an image to a library.

Before You Begin
1. Start Windows 95/NT.

2. Select “Scan ’n Store” from the “Scan ’n Store” group in the
Start Menu.

3. Use the procedures from Section 1 to open the Accounts Payable
library.
(Do not open the “Accounts Payable (Single pages)” library.)
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Lesson 1: Scan a Document
Before you begin adding documents to a library, you need to scan
them and save them as image files.

To scan a document using Scan ’n Store:

1. In the File menu, select Scan….
(A dialog box showing scanning options appears.)

2. Click Load Driver.
(The Choose Driver dialog box appears, showing any
installed scanners.)

3. Click Advanced….
(The Open dialog box displays.)

4. Double-click on the Fakescsi.drv file shown in the dialog
box.

5. Click in the Scanner box to display a drop down list of
scanners supported by the driver you chose.
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6. Click on “RICOH IS520” from the list.
(The options available in the Scanner and Job areas of the
dialog box should change from gray to white.)

 Not all scanners support each of the options shown in the dialog box.
You can click on the other scanners in the Scanner drop-down
list to see how the available options change depending on which
scanner you select. Before you go on to step 7, make sure
“RICOH IS520” is the selected scanner.

7. Click on Back to set the scanner to scan the back side of a
page.
(Both Front and Back should be checked at this point.)

8. Click on the Resolution arrow and choose “200” from the
drop-down list.

9. Click on the Page Size arrow and choose “Legal (8.5" x
14")” from the drop-down list.

10. Click Scan .
(The Page status bar will show the progress of a scan and
the Cancel button changes to Stop Scanning.)

11. After the scan completes, click Close.
(Scan ’n Store adds the scanned image to a batch which
holds images until they are indexed and added to a library.)

 Scan ’n Store will remember which driver you choose, which
scanner you select, and how you configure the scanning options.
The next time you click Scan…, the dialog box will
automatically fill with the last set of options you used.
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12. Click the Index tab to view the Batch contents.
(The Batch Index tab in the bottom of the Scan ’n Store
Window becomes active.)

13. In the Index tab, click on the folder.
(The closed folder changes to an open folder, the name of a
Scan ’n Store user appears in the Locked By column, and a
solid black image created by the test scan fills the Image
Viewer.)

14. In the Batch Index tab, click anywhere in the row to select
the scanned image.

15. Press CTRL+DELETE to remove the image from the batch.
(An alert dialog box appears to ask if you really want to
delete the image.)

16. Click Yes.
(The image disappears and the folder says “No images to
index.”)
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Lesson 2: Import an Image
The first step in adding images to a library is to select which images
you want to include.

To select an image to enter into the library:

1. Click  in the File toolbar.
(The Open dialog box displays.)

2. Double-click on the test1.tif file.

3. Click the Index tab.

4. In the Index tab, click the folder.
(A contract for AIIM 98 Exhibit Space should display in the
Image Viewer.)

Lesson 3: ScanFix an Image
Images are often scanned at angles that make them awkward to read
and print. Scan ’n Store includes the ScanFix utility to help
overcome angled, or skewed, images.

The contract shown in the Image Viewer is skewed. Lets fix that
before we enter it into the library.

To ScanFix an image:

1. Click  in the Image toolbar.
(A dialog box should appear to allow you to select which
pages of this multi-page TIFF you want to affect. All these
pages should appear selected.)

2. Click Fix Image to ScanFix all pages.
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3. If you like the changes ScanFix made, click Save to save the
changes.

If you do not like the change, click Cancel.
(The image should look like it did before your used
ScanFix.)

Lesson 4: Check the Field Name Configurations
When a library is created the person creating it decides what Field
Names will is required and what data is optional.

To check for required fields in the open library:

•  Look at the image list in the Batch Index tab. All column
headings in red indicate they are required. Notice that the
Date, Paid, Purchase Order, and Company fields are
required for any image entered into the library.

Lesson 5: Index an Image
The Batch Index tab displays a table with a list of field names
available to describe the image you want to add to the library. You
should enter as much information as necessary to make the image
easy to locate when someone tries to find it using the Search tab.

Assign Keywords to Field Names

1. Click in the Date field.
(The current date appears in the field.)

2. Select the date 12/15/97 using one of the following methods.

•  Click in each of the date/month/year areas and type the
values.
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•  Click in each of the date values and use the spin box
(  ) to select the values.

•  Click  to display a calendar, then use the calendar to
select the date.

3. Press TAB to move focus to the Paid field.

4. Type “No” in the field

5. Click in the Purchase Order field.

6. Type “15709” in the field.

7. In the Image menu, click Add Batch to Library.

 You should have gotten a message saying “0 images added to the
library.” Scan ’n Store will not allow you to enter an image into
the library without filling in all the required fields.

8. Click in the Company field.

9. Click  to display a drop-down list of company names
already used in the library.

10. Click Knowledge Asset. Media.
(The selection fills the field.)

11. Again, in the Image menu, click Add Batch to Library.
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To make sure the image is actually in the library, use the Search tab to
locate and display the image.

Go to “Section 3: Making a New Library”
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Section 3: Making a New Library
The lessons in this chapter use the sample image file installed with
Scan ’n Store. After reading Section 1 and completing the lessons in
Sections 2 and 3, you are ready to make your own Scan ’n Store
database.

In this chapter, you will learn how to do the following:

•  Create a database for a new library.

•  Create Field Names for information that will describe
images stored in the library.

•  Assign Field Types to determine what type of information
can be associated with specific field names.

•  Determine whether or not specific field names will be
required when adding images to the new library.

•  Add an image to a Scan ’n Store image library.

•  Export images to a new Scan ’n Store image library.

Before You Begin
1. Start Windows 95/NT.

2. Select “Scan ’n Store” from the “Scan ’n Store” group in the
Start Menu.
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Lesson 1: Create a Database
The first step in creating a new library is to create a Scan ’n Store
database so you will know where the images are and can keep track
of them.

1. Click  in the File toolbar to start the New Library
Wizard.

2. Click  to display the New Library Name dialog box,

3. Type “MyLibrary” in the File name box.

4. Click Open.
(The dialog box closes and the path to the new library
appears in the Wizard.)
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5. Click Next.
(The Choose Image Directories pane appears. We will use
the default values.)

6. Click Next.
(An Open Error dialog box will display indicating that the
libraries do not exist.)

7. Click Yes to create the directories.

8. Click Finish to create the new library.
(After the New Wizard closes, Scan ’n Store displays the
Library tab from the Options dialog box so you can assign
categories to your library.)

9. Click Cancel.
(The Options dialog box closes.)
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Lesson 2: Assign Categories to a Library
Field Names help users navigate through the images in a library by
assigning meaningful topics or categories for users to search. In our
example, let’s assume our new library will hold images of archived
user manuals for software development kits (SDKs) at Software
Tools Company. One way to categorize these images would be to
identify the operating system (DOS, Windows 95/NT, OS/2 UNIX,
etc.) the SDKs were written for.

To assign a field name:

1. Click  in the File toolbar to re-open the Options dialog
box.

2. Choose the Library tab from the Options dialog box.
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3. Click Add Field… to open the Add Field dialog box.

4. From the Add Field dialog box, click in the Name box and
type “Operating System”.

5. Click in the Required? check box.

6. Click OK.
(The new category appears in the Library tab.)

7. Click Add Field… to open the Add Field dialog box.
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8. From the Add Field dialog box, click in the Name box and
type “ChapNum” to create a field for chapter numbers.

9. Click in the Type box and select Integer.

10. Click OK.

11. Click Add Field… to open the Add Field dialog box.

12. From the Add Field dialog box, click in the Name box and
type “ChapTitle” to create a field for chapter titles.

13. Click OK.
(The Library tab now shows all three categories.)

14. Click OK in the Options dialog box to save your changes
and close the dialog box.
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Lesson 3: Add Images to New Libraries
Adding images to new libraries is the same as adding images to
existing libraries (See “Chapter 4: Entering Images Into Existing
Image Libraries.”)

1. Click  in the File toolbar.
(The Open dialog box displays.)

2. Double-click on the “test2.tif” file.

3. Click the Index tab.

4. In the Index tab, click the folder.
(A chapter page should display in the Image Viewer.)

5. Click  in the Image toolbar.

6. Click Fix Image to ScanFix the page.
(The image should re-align without an angle.)

7. Click Save to save the changes.
(The “fixed” image appears in the Image Viewer.)

8. In the Batch Index tab, click in the “Operating System”
field.
(Remember, this is a required field and should appear in red
type.)

9. Type “Windows 95” in the “Operating System” field.

10. Type “1” in the “ChapNum” field.

11. Type “Overview of the Windows SDK” in the “ChapTitle”
field.
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12. In the Image menu, click Add Batch to Library.
(Scan ’n Store adds the image to the library. The image will
disappear from the Batch Index tab and Image Viewer.)

 To make sure the image is in the library, look for the image in the
FlexFolders tree.

13. Click on the FlexFolders tab to display the tree.

14. Click on the “+” box to expand the tree and show your
image.

Lesson 4: Export Images to New Libraries
After you perform a search and Scan ’n Store returns a list of images
that match your search criteria, you might want to export that group
of similar images to their own library. For example, suppose you
wanted to create new libraries for the Software Tools Company user
manuals so each library contained only user manuals associated with
specific operating systems.
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1. Click  to start the Export Wizard .
(The Select Data Set pane appears.)

2. Choose Export all data and images.

3. Click Next.
(The Select Destination Database pane appears)

4. Click  to display the Destination Database dialog box.
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5. Go to the directory containing MyLibrary.mdb and type
“MyExport” in the File name box.

(The dialog boxcloses and the path to the export database
appears in the Select Destination Database pane.)
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6. Click Next.
(An alert dialog box appears.)

7. Click Yes.
(The Choose Image Directories pane appears. We will use
the default values for our export directory.)

8. Click Next.
(Another alert dialog box appears.)
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9. Click Yes.
(The Complete pane appears in the wizard.)

10. Click Finish.
(Scan ’n Store begins exporting the images and data to the
new export database.)

End of Tutorial
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